# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>4</td>
</tr>
<tr>
<td>Document Overview</td>
<td>5</td>
</tr>
<tr>
<td>Documentation Organization</td>
<td>5</td>
</tr>
<tr>
<td>Conventions</td>
<td>5</td>
</tr>
<tr>
<td>Related Documentation</td>
<td>6</td>
</tr>
<tr>
<td>Customer Care</td>
<td>7</td>
</tr>
<tr>
<td>User Accounts</td>
<td>7</td>
</tr>
<tr>
<td>Software Upgrades</td>
<td>7</td>
</tr>
<tr>
<td>Technical Support</td>
<td>7</td>
</tr>
<tr>
<td>Chapter 1 Introduction</td>
<td>8</td>
</tr>
<tr>
<td>About Infoblox vNIOS Virtual Appliance for VMware</td>
<td>9</td>
</tr>
<tr>
<td>Requirements</td>
<td>11</td>
</tr>
<tr>
<td>Chapter 2 Deploying vNIOS Appliances</td>
<td>12</td>
</tr>
<tr>
<td>Deploying vNIOS Appliances on VMware</td>
<td>13</td>
</tr>
<tr>
<td>Installing the vNIOS Virtual Appliance</td>
<td>14</td>
</tr>
<tr>
<td>Obtaining and Installing Your VM Licenses</td>
<td>15</td>
</tr>
<tr>
<td>Configuring the Virtual NICs</td>
<td>18</td>
</tr>
<tr>
<td>Chapter 3 Configuring SRE-V Service Module to Install vNIOS Appliance</td>
<td>20</td>
</tr>
<tr>
<td>Configuring the SRE-V Service Module and Installing the vNIOS Software</td>
<td>21</td>
</tr>
<tr>
<td>Chapter 4 Configuring vNIOS Appliance as Grid Members</td>
<td>24</td>
</tr>
<tr>
<td>About Infoblox Grids</td>
<td>25</td>
</tr>
<tr>
<td>Setting Up a Grid</td>
<td>25</td>
</tr>
<tr>
<td>Configuring vNIOS Appliances as Grid Masters</td>
<td>26</td>
</tr>
<tr>
<td>Specifying Initial Settings on vNIOS Grid Masters</td>
<td>26</td>
</tr>
<tr>
<td>Configuring the vNIOS Virtual Appliance as a Grid Master</td>
<td>27</td>
</tr>
<tr>
<td>Configuring vNIOS Appliances as Grid Members</td>
<td>29</td>
</tr>
<tr>
<td>Provisioning vNIOS Members on the Grid Master</td>
<td>29</td>
</tr>
<tr>
<td>Configuring and Joining vNIOS Grid Members</td>
<td>30</td>
</tr>
<tr>
<td>Transferring vNIOS Licenses</td>
<td>31</td>
</tr>
<tr>
<td>Obtaining Replacement vNIOS Licenses</td>
<td>31</td>
</tr>
<tr>
<td>Installing New vNIOS Licenses</td>
<td>31</td>
</tr>
<tr>
<td>Configuring HA Pairs for License Transfers</td>
<td>32</td>
</tr>
<tr>
<td>Removing vNIOS Appliances from the Grid</td>
<td>33</td>
</tr>
<tr>
<td>Migrating vNIOS Appliances</td>
<td>33</td>
</tr>
<tr>
<td>Verifying and Monitoring</td>
<td>34</td>
</tr>
<tr>
<td>Appendix A Known Limitations</td>
<td>36</td>
</tr>
</tbody>
</table>
Preface

The preface describes the content and organization of this guide, how to find additional product information, and how to contact Infoblox Technical Support. It includes the following topics:

- **Document Overview** on page 5
  - **Documentation Organization** on page 5
  - **Conventions** on page 5
- **Related Documentation** on page 6
- **Customer Care** on page 7
  - **User Accounts** on page 7
  - **Software Upgrades** on page 7
  - **Technical Support** on page 7
**Document Overview**

This guide introduces the Infoblox vNIOS virtual appliance for VMware, including the Infoblox Grids. It describes how to install the Infoblox vNIOS virtual appliance 5.1r4-5 and later releases and 6.2.0 and later releases on VMware ESX/ESXi server and Cisco SRE-V (Services Ready Engine Virtualization). How to configure the vNIOS virtual appliance as a Grid Master and Grid member, and how to transfer valid licenses between vNIOS appliances.

For complete information about administering Infoblox appliances, refer to the *Infoblox NIOS Administrator Guide*. For the latest Infoblox documentation, visit the Infoblox Support web site at [https://support.infoblox.com](https://support.infoblox.com).

**Documentation Organization**

This guide covers the following topics:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Chapter 1, Introduction</em>, on page 8</td>
<td>Provides information about the Infoblox vNIOS virtual appliance and requirements to install on VMware ESX/ESXi server 4.x or ESXi server 5.x.</td>
</tr>
<tr>
<td><em>Chapter 2, Deploying vNIOS Appliances</em>, on page 12</td>
<td>Describes how to install the Infoblox vNIOS virtual appliance on VMware ESX/ESXi server 4.x or ESXi server 5.x.</td>
</tr>
<tr>
<td><em>Chapter 3, Configuring SRE-V Service Module to Install vNIOS Appliance</em>, on page 20</td>
<td>Describes how to install the Infoblox vNIOS virtual appliance and how to deploy a vNIOS virtual appliance as a Grid Master and a Grid member. It also describes how to transfer licenses between vNIOS appliances.</td>
</tr>
<tr>
<td><em>Chapter 4, Configuring vNIOS Appliance as Grid Members</em>, on page 24</td>
<td>Describes how to install Cisco SRE-V service module and how to configure a vNIOS appliance.</td>
</tr>
</tbody>
</table>

**Conventions**

This guide follows the Infoblox documentation style conventions, as listed in the following table.

<table>
<thead>
<tr>
<th>Style</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>Indicates anything that you input by clicking, choosing, selecting, typing or by pressing on the keyboard.</td>
</tr>
<tr>
<td><strong>input</strong></td>
<td>Signifies command line entries that you type.</td>
</tr>
<tr>
<td><strong>variable</strong></td>
<td>Signifies variables typed into the GUI that you need to modify specifically for your configuration, such as command line variables, file names, and keyboard characters.</td>
</tr>
</tbody>
</table>

**Navigation**

Infoblox technical documentation uses an arrow “→” to represent navigation through the GUI. For example, to access member information, the description is as follows:

From the **Grid** tab, select the **Grid Manager** tab → **Members** tab.
OTHER NIOS APPLIANCE DOCUMENTATION:

- Infoblox NIOS Administrator Guide
- Infoblox CLI Guide
- Infoblox API Documentation
- Infoblox CSV Import Reference
- Infoblox Installation Guide for the Trinzic 100 Appliance
- Infoblox Installation Guide for the Infoblox-4010 and Network Insight ND-4000 Platforms
- Infoblox Installation Guide for Infoblox Advanced Appliance PT-1400
- Infoblox Installation Guide for Infoblox Advanced Appliance PT-2200
- Infoblox Installation Guide for Infoblox Advanced Appliance PT-4000
- Infoblox Installation Guide for the Infoblox-4030 Appliance
- Infoblox DNS Caching Acceleration Application Guide
- Infoblox Installation Guide for the Trinzic Reporting 1400 Appliance
- Infoblox Installation Guide for the Trinzic Reporting 2000 Appliance
- Infoblox Installation Guide for the Trinzic Reporting 2200 Appliance
- Infoblox Installation Guide for the Trinzic Reporting 4000 Appliance
- Infoblox Installation Guide for Installing vNIOS Software on Cisco Platforms
- Infoblox Installation Guide for vNIOS on Microsoft 2008 R2 for Hyper-V
- Quick Start Guide for Installing vIBOS Software on VMware Platforms
- Infoblox IBOS Administrator Guide
- Infoblox Safety Guide

To provide feedback on any of the Infoblox technical documents, please email techpubs@infoblox.com.
**Customer Care**

This section addresses user accounts, software upgrades, licenses and warranties, and technical support.

**User Accounts**

The Infoblox appliance ships with a default user name and password. Change the default `admin` account password immediately after the system is installed to safeguard its use. Make sure that the NIOS appliance has at least one administrator account with superuser privileges at all times, and keep a record of your account information in a safe place. If you lose the `admin` account password, and did not already create another superuser account, the system will need to be reset to factory defaults, causing you to lose all existing data on the NIOS appliance. You can create new administrator accounts, with or without superuser privileges.

**Software Upgrades**

Software upgrades are available according to the Terms of Sale for your system. Infoblox notifies you when an upgrade is available. Register immediately with Infoblox Technical Support at [http://www.infoblox.com/support/customer/evaluation-and-registration](http://www.infoblox.com/support/customer/evaluation-and-registration) to maximize your Technical Support.

**Technical Support**

Infoblox Technical Support provides assistance via the Web, e-mail, and telephone. The Infoblox Support web site at [https://support.infoblox.com](https://support.infoblox.com) provides access to product documentation and release notes, but requires the user ID and password you receive when you register your product online at: [http://www.infoblox.com/support/customer/evaluation-and-registration](http://www.infoblox.com/support/customer/evaluation-and-registration).
Chapter 1  Introduction

This chapter provides information about the Infoblox vNIOS virtual appliance for VMware. It also describes the requirements to install the vNIOS virtual appliance on VMware ESX/ESXi server 4.x or ESXi server 5.x. It includes the following topics:

•  *About Infoblox vNIOS Virtual Appliance for VMware*  on page 9
•  *Requirements*  on page 11
About Infoblox vNIOS Virtual Appliance for VMware

The Infoblox vNIOS on VMware software can run on ESX or ESXi servers that have DAS (Direct Attached Storage), or iSCSI (Internet Small Computer System Interface) or FC (Fibre Channel) SAN (Storage Area Network) attached. You can install the vNIOS software package on a host with VMware ESX or ESXi 4.x or 5.x installed and configure it as a virtual appliance. You can also install the vNIOS software on Cisco SRE-V (Services Ready Engine Virtualization). It enables customers to deploy large, robust, manageable and cost effective Infoblox Grids. For information about Infoblox Grids, see Configuring the SRE-V Service Module and Installing the vNIOS Software on page 18.

The Infoblox NIOS provides core network services and a framework for integrating all the components of the modular Infoblox solution. Infoblox NIOS provides integrated, secure, and easy-to-manage DNS (Domain Name System), DHCP (Dynamic Host Configuration Protocol) and IPAM (IP address management) services. In addition to DNS, DHCP and IPAM, the NIOS software also provides TFTP, HTTP, NTP, and FTP file transfer services.

Infoblox vNIOS virtual appliance for VMware provides most of the features supported by the NIOS, with some limitations. (For information, see Known Limitations on page 33.) vNIOS appliances support the following features:

- Supports configuration as an HA pair, a Grid master, or a Grid master candidate
- Anycast addressing
- OSPF
- BGP
- Static routes
- IPv6

vSphere vMotion is also supported. You can migrate vNIOS virtual appliances from one ESX or ESXi server to another without any service outages. The migration preserves the hardware IDs and licenses of the vNIOS virtual appliances. VMware Tools is automatically installed for each vNIOS virtual appliance. Infoblox supports the control functions in VMware Tools. For example, through the vSphere client, you can shut down the virtual appliance. For information about migrating a vNIOS virtual appliance, see Migrating vNIOS Appliances on page 30.

You can configure most vNIOS appliances as independent or HA (high availability) Grid Masters, Grid Master candidates, and Grid members. Table 1.1 lists the vNIOS appliance models and their specifications.

Basic VM disk allocations include the following:

- IB-VM-100, IB-VM-810, IB-VM-820, and IB-VM-1410 vNIOS appliances support 55 GB or 160 GB hard disk allocation.
- IB-VM-1420, IB-VM-2210, and IB-VM-2220 vNIOS appliances support 160 GB hard disk allocation.
- Cloud Platform CP-800, CP-1400, and CP-2200 vNIOS appliances support 160 GB hard disk allocation.
- Network Insight ND-V800, ND-V1400 and ND-V2200 vNIOS appliances support 160 GB hard disk allocation.
- 50 GB and 55 GB vNIOS virtual appliances and Network Insight VM models support Grid member status, but do not support Grid Master or Grid Master Candidate operation.

Note: Each vNIOS virtual appliance requires a unique hardware ID. Infoblox does not support cloned VM instances as vNIOS virtual appliances.
Table 1.1  vNIOs on VMware Appliance Models

<table>
<thead>
<tr>
<th>Trinzic Series Virtual Appliances</th>
<th>Disk (GB)</th>
<th># of CPU Cores</th>
<th>Memory Allocation</th>
<th>Virtual CPU Core Frequency</th>
<th>Supported as Grid Master and Grid Master Candidate (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IB-VM-100</td>
<td>55</td>
<td>1</td>
<td>1 GB</td>
<td>1300 MHz</td>
<td>No</td>
</tr>
<tr>
<td>IB-VM-800 (Reporting only)*</td>
<td>55</td>
<td>2</td>
<td>2 GB</td>
<td>3000 MHZ</td>
<td>No</td>
</tr>
<tr>
<td>IB-VM-810</td>
<td>55</td>
<td>2</td>
<td>2 GB</td>
<td>2000 MHz</td>
<td>No</td>
</tr>
<tr>
<td>IB-VM-810</td>
<td>160</td>
<td>2</td>
<td>2 GB</td>
<td>2000 MHz</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-820</td>
<td>55</td>
<td>2</td>
<td>2 GB</td>
<td>3000 MHz</td>
<td>No</td>
</tr>
<tr>
<td>IB-VM-820</td>
<td>160</td>
<td>2</td>
<td>2 GB</td>
<td>3000 MHz</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-1400 (Reporting only)*</td>
<td>160</td>
<td>4</td>
<td>8 GB</td>
<td>6000 MHz</td>
<td>No</td>
</tr>
<tr>
<td>IB-VM-1410</td>
<td>55</td>
<td>4</td>
<td>8 GB</td>
<td>6000 MHz</td>
<td>No</td>
</tr>
<tr>
<td>IB-VM-1410</td>
<td>160</td>
<td>4</td>
<td>8 GB</td>
<td>6000 MHz</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-1420</td>
<td>160</td>
<td>4</td>
<td>8 GB</td>
<td>8000 MHz</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-2210</td>
<td>160</td>
<td>4</td>
<td>12 GB</td>
<td>10000 MHz</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-2220</td>
<td>160</td>
<td>4</td>
<td>12 GB</td>
<td>12000 MHz</td>
<td>Yes</td>
</tr>
<tr>
<td>Cloud Virtual Appliances</td>
<td>Disk (GB)</td>
<td># of CPU Cores</td>
<td>Memory Allocation</td>
<td>Virtual CPU Core Frequency</td>
<td>Supported as Grid Master and Grid Master Candidate (Yes/No)</td>
</tr>
<tr>
<td>CP-V800</td>
<td>160</td>
<td>2</td>
<td>2 GB</td>
<td>3000 MHZ</td>
<td>No</td>
</tr>
<tr>
<td>CP-V1400</td>
<td>160</td>
<td>4</td>
<td>8 GB</td>
<td>6000 MHZ</td>
<td>No</td>
</tr>
<tr>
<td>CP-V2200</td>
<td>160</td>
<td>4</td>
<td>12 GB</td>
<td>10000 MHZ</td>
<td>No</td>
</tr>
<tr>
<td>Network Insight Virtual Appliances</td>
<td>Disk (GB)</td>
<td># of CPU Cores</td>
<td>Memory Allocation</td>
<td>Virtual CPU Core Frequency</td>
<td>Supported as Grid Master and Grid Master Candidate (Yes/No)</td>
</tr>
<tr>
<td>ND-V800*</td>
<td>160</td>
<td>2</td>
<td>2 GB</td>
<td>3000 MHZ</td>
<td>No</td>
</tr>
<tr>
<td>ND-V1400*</td>
<td>160</td>
<td>4</td>
<td>8 GB</td>
<td>6000 MHZ</td>
<td>No</td>
</tr>
<tr>
<td>ND-V2200*</td>
<td>160</td>
<td>4</td>
<td>12 GB</td>
<td>10000 MHZ</td>
<td>No</td>
</tr>
</tbody>
</table>

Note: * This virtual appliance does not support Elastic Scaling.
**Requirements**

You can install the Infoblox vNIOS virtual appliance on VMware ESX/ESXi server 4.x or ESXi server 5.x and configure it as one of the supported virtual appliances. You can configure the storage with 50 GB/55 GB/120 GB/160 GB depending on the appliance model. For information about model specifications, see [Table 1.1](#) on page 10. Note that the vNIOS virtual appliance can run on ESX or ESXi servers that have DAS (Direct Attached System) or iSCSI (Internet Small Computer System Interface) SAN (Storage Area Network) attached. For information about VMware products, refer to the VMware documentation.

You can also install the vNIOS virtual appliance on Cisco SRE-V, which is part of the Cisco UCS (Unified Computing System) Express. Cisco SRE-V enables the VMware vSphere™ Hypervisor to be provisioned on Cisco SRE 700 and 900 Service Modules. The Cisco SRE Service Module can reside either in the Cisco 2900 series or 3900 series ISR G2. The service module must have SRE-V version 1.0.1 with OS 15.1(3)T or later installed. For more information about Cisco SRE-V, refer to the Cisco documentation.

The following table lists the supported vNIOS appliance models on VMware with Cisco SRE 700 and SRE 900 service modules.

<table>
<thead>
<tr>
<th>vNIOS on VMware</th>
<th>Cisco SRE 700</th>
<th>Cisco SRE 900</th>
</tr>
</thead>
<tbody>
<tr>
<td>IB-VM-BOB</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-250</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-550</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-1050</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-810</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>IB-VM-820</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The following are required to install the vNIOS virtual appliance on a VMware ESX or ESXi server or Cisco SRE-V platform:

- The vNIOS software package. You can download the vNIOS software from the Infoblox Technical Support site. To download the software, you must have a valid login account on the Infoblox Support site. Register your product at [https://support.infoblox.com](https://support.infoblox.com) if you do not already have an account. The vNIOS software package consists of a template file with .ova extension for all the supported vNIOS appliance models. Make sure that you download the file with an extension that corresponds to the appliance model number. For example, to install IB-VM-550 with a 50 GB disk on VMware ESX or ESXi servers, download nios-X.X.X-241423-201X-05-26-08-02-40-50G-550.ova. For IB-VM-810 with a 160 GB disk, download the file that has the extension xxxx-160G-810.ova. For information about the vNIOS appliance models on VMware, see [Table 1.1](#) on page 10.

  **Note:** After you download the .ova file, you can run the `tar -xvf nios-xxx.ova` command to untar the .ova and separate .ovf and .vmdk files.

You can deploy the vNIOS virtual appliance from a remote web server or a local file system accessible from your management system.

- A management system that has an installed vSphere Client. To manage multiple hosts, the vSphere Client must be connected to the vCenter Server system.
Chapter 2  Deploying vNIOS Appliances

This chapter describes how to deploy the vNIOS virtual appliance on VMware using vSphere Client. This chapter includes the following topics:

- Deploying vNIOS Appliances on VMware on page 13
  - Installing the vNIOS Virtual Appliance on page 14
  - Starting your vNIOS Virtual Appliance using vSphere Client on page 15
  - Obtaining and Installing Your VM Licenses on page 15
    - Obtaining License Keys for Existing VM Instances on page 16
    - Running the Show License Command on page 17
    - Downloading License Keys for Multiple VM Instances on page 17
  - Configuring the Virtual NICS on page 18

vNIOS virtual appliances will not operate without a license. To ensure that your VMs will operate until you can install permanent license keys, you can run the `set temp_license` command in the NIOS command line for any VM. For information, see the section Managing Licenses in the NIOS Administrator Guide.
Deploying vNIOS Appliances on VMware

Before setting up a vNIOS appliance as a Grid Master or Grid member, you install the virtual appliance on the VMware or Cisco-SRE-V platform. The instructions in this section assume that you have configured the server on your network, and you are able to connect to it from your management station. (For information about configuring the VMware products and Cisco SRE-V, refer to the VMware and Cisco documentation respectively.) Infoblox recommends that you back up your existing configuration before deploying a vNIOS virtual appliance.

- Order your virtual Infoblox (vNIOS) appliances from your Infoblox representative.
- If you plan to use Elastic Scaling for deployment, obtain dynamic licenses for the features you want to use. For information about Elastic Scaling, refer to the About Elastic Scaling section of the Infoblox NIOS Administrator Guide.
- If you have one or more NIOS VMs already running on your server under a temporary license(s), ensure that the temporary licenses are not expired before you establish a permanent license on each VM. Should any of the respective temporary licenses be expired, the process of applying a permanent license to the VM entails a complete reset of all data and settings in the VM to factory defaults. Prior backups from a VM with an expired temporary license remain valid and restored backups from a temporary-licensed VM will not override a newly installed permanent license.
- Make a record of your VM registration numbers from the Contract Notification email sent to you after purchase of your virtual appliances.

To deploy a vNIOS appliance, log in to the vSphere Client, connect to the ESX or ESXi server or Cisco SRE-V, and then complete the following:

1. Download the vNIOS virtual machine image files from the Infoblox Support site.
2. Install the vNIOS virtual appliance on the server, as described in Installing the vNIOS Virtual Appliance.
3. If you are using Elastic Scaling for your deployment, log in to the NIOS GUI (Grid Manager) and do the following,
   - Create offline Grid members you plan to join the Grid.
   - Pre-provision these Grid members.
   - Generate a token for each member. Copy the certification and token strings and save it for later use.
   For detailed instructions on how to pre-provision a member and obtain a token, refer to the Infoblox NIOS Administrator Guide.

   **Note:** Elastic Scaling for the Grid Master and HA (High Availability) is not supported.

4. Start up the new vNIOS instance(s) on the ESX server, as described in Starting your vNIOS Virtual Appliance using vSphere Client.
5. As you install and start each VM, use the `show hwid` command to obtain the Hardware ID number for the new VM; then, make a record of the Hardware ID number and the VM Registration Number for each VM.
6. Download and Install the license or licenses for your vNIOS virtual appliance or appliances as described in Obtaining and Installing Your VM Licenses.
7. Configure the NICs (Virtual Network Adapters) of the vNIOS appliance, as described in Configuring the Virtual NICs.
8. Register each of your virtual appliances through the Infoblox Support portal.
Installing the vNIOS Virtual Appliance

1. Order the Infoblox vNIOS Virtual Appliance(s) from Infoblox.
   The purchaser receives a Contract Notification email from Infoblox Sales containing the licensing information for each purchased virtual machine. The email has the VM registration numbers that are assigned directly to each VM.
   
   **Note:** The purchaser needs to ensure that the technical personnel that will be installing and configuring the VMs receive a copy of the Contract Notification email, because the VM operators need to correlate the Hardware ID values for each VM to the VM registration number for each virtual machine. For details, see the section *Downloading License Keys for Multiple VM Instances.*

2. Download the .OVA package file(s) from the FTP site.
   If you have ordered multiple model types for your VMs, you will need an .OVA package file for each model type (V820, V1410, etc.); you can deploy multiple virtual appliances of the same model type from each downloaded image. Once the image is installed on the ESX server, a unique Hardware ID is created. You look up this Hardware ID value after you start up each VM. This Hardware ID value is the second key piece of information you need to establish your permanent license for each vNIOS VM.
   You need the .OVA package file for the following step.

3. From the vSphere Client, click File -> Deploy OVF Template to start the *Deploy OVF Template* wizard, as shown in *Figure 2.1.* You use this feature to open the .OVA file for your VM deployment.

   **Figure 2.1 Deploy OVF Template Wizard**

4. Depending on the download location of the vNIOS virtual appliance, select Deploy from file to deploy the .OVA file from a local file system, or select Deploy from URL to deploy from a remote web server. Locate the .OVA file or enter the URL of the file, and then click Next.

5. Verify the .OVA package file details and click Next.

6. Specify a name for the vNIOS instance and click Next.

7. Select the network of the vNIOS instance and click Next.

8. In the summary screen, ensure that you DO NOT select the *Power on after deployment* check box if you are using Elastic Scaling for your deployment. Verify the information in the summary screen and click Finish.
Deploying vNIOS Appliances on VMware

The vNIOS installation begins. The Deployment Completed Successfully dialog box appears after the installation is complete.

9. Click Close to close the dialog box.

10. To verify the installation of the virtual appliance, click the Virtual Machines tab in the vSphere Client.

Starting your vNIOS Virtual Appliance using vSphere Client

1. From the vSphere Client, select the vNIOS instance.

2. If you are using Elastic Scaling for the deployment, right click Edit Settings, select the Options tab -> Properties, and then complete the following. Otherwise, go the next step.
   - Temp License: Enter the licenses you want to install on the vNIOS instance. Depending on whether you are deploying the Grid Master or the Grid member, you may install temporary licenses for the Grid Master and dynamic licenses for the Grid member. Use a space or comma (,) to separate the licenses. For example, you can enter dns vnios enterprise.
   - Enable Remote Console: Enter Enable to enable the remote console.
   - Admin Password: Enter the admin password for the appliance. The default password is infoblox.

   In the Grid Master section, enter information for the Grid member that you are configuring, as follows:
   - Certificate: Here, paste the string for the Infoblox NIOS certificate credential generated for the Grid member token.
   - IP Address: Enter the IP address for the Grid Master.
   - Token: Here, paste the security token generated for the new vNIOS for VMware instance.

   **Note:** The certificate and token are generated on the Grid Master when you pre-provision the vNIOS instance. The certificate and token values are valid only for a period of time. For information, see About Elastic Scaling in the Infoblox NIOS Administrator Guide.

3. Click Inventory -> Virtual Machine -> Power -> Power On.

   **Note:** After you power on the virtual appliance, it takes a few minutes for the CLI prompt to appear while the appliance initializes.

4. Go to the following section if you are not using Elastic Scaling, Obtaining and Installing Your VM Licenses.

Obtaining and Installing Your VM Licenses

Make a note of the hardware IDs that you obtain during this procedure. Each of these unique Hardware ID values can be associated with a VM Registration Number from your Contract Notification email.

1. After the VM starts, open a terminal session for the VM and open the NIOS command line.

2. Run the command show hwid.
   ```
   nios-vm-ib-1420-gm > show hwid
   Hardware ID: 564d41e13a1cc55affb9bad4e3b5c48a
   Copy and paste the Hardware ID value for convenience.
   ```
You can also run a `show license` command to obtain the same information:

```
nios-vm-ib-1420-gm > show license
Version : 6.11.0-248090
Hardware ID : 564d41e13a1cc55affb9bad4e3b5c48a
```

**Note:** If a license key is installed for the current VM, that key value also appears in the output for the `show license` command.

3. Go to https://support.infoblox.com/app/licenses (you will have to log in with your support account and click the Licenses menu). On the Licenses page, open the Submit a license key registration form.
4. Enter or copy and paste the Hardware ID value you obtained in Step 2 of this procedure, in both fields:
   - Serial Number
   - Hardware ID
   Both values are synonymous.
5. Under the Service and Maintenance categories, select the check boxes for all options for which you have purchased service licenses and/or maintenance licenses.
6. Enter any Comments if needed.
7. Click Submit to submit the request for your license keys.
8. Repeat the previous steps for all other vNIOS VM instances.

Infoblox Technical Support normally processes license key requests on the same day they are received; however, allow 24-48 hours for processing. When you receive the license keys, follow the steps in the procedure Managing Licenses in the NIOS Administrator’s Guide to install the licenses in the vNIOS VM.

**Note:** Each VM Registration Number should have a Hardware ID associated with it. As you install and spin up each virtual machine, establish written records for each Hardware ID with the VM Registration Numbers in a one-to-one ratio. These value pairs are necessary should you need to contact Infoblox Support.

### Obtaining License Keys for Existing VM Instances

If you are unsure of the license entitlements for one or more of your vNIOS VMs, or want to obtain a new listing of your license keys for any reason, do the following:

1. Go to https://support.infoblox.com/app/licenses (you will have to log in with your support account and click the Licenses menu). On the Licenses page, open Download License Key(s) for one appliance.
   
   This feature recognizes that any VM is likely to have multiple feature licenses, all of which are tied to a specific Hardware ID.

2. Enter the Hardware ID number in the Enter one number: field. An example:

   ```
   Enter one number: 564d41e13a1cc55affb9bad4e3b5c48a
   ```

   Note that serial numbers and Hardware IDs are the same value.
3. Select how your license key will be provided:
   - Display to Screen
   - Send File
   - .CSV

   The Display to Screen and Send File options allow for direct copying and pasting. Using a .CSV file enables you to use the convenient Upload License File feature for your appliance in NIOS. For more information, see the section Managing Licenses in the NIOS Administrator’s Guide.

4. After making your selection, click Generate Keys at the bottom of the panel. An example:

   ![License Table]

5. After you receive your key values (there will likely be more than one for each VM), you can save them for your records. If you need to install a specific license or licenses, use the method you prefer as described in the Managing Licenses section in the NIOS Administrator’s Guide; either pasting in the license data, or uploading the CSV file.

Running the Show License Command

You can also run a show license command to obtain the same information for an individual VM, which also indicates the license types for the VM:

```
nios-vm-ib-1420-gm > show license
Version : 6.11.0-248090
Hardware ID : 564d41e131cc55affb9bad4e3b5c48a
License Type : Grid Maintenance
Expiration Date : 04/20/2017
License String : GwAAAPTTiCcwDNj0O4nyOTGdFZ7pot6WQ2XOSiqisg==
```

If license keys are installed for the current VM, those key values also appear in the output for this command listed for each license entitlement.

Downloading License Keys for Multiple VM Instances

The Support pages provide a method for downloading the license keys for multiple VM instances, based on the purchased feature licenses for your products.

1. Obtain the Hardware ID values by following steps 1–3 in the previous procedure, Obtaining and Installing Your VM Licenses, for each of your VMs. Do this in the order shown from top to bottom of your Contract Notification email.

As an alternative, you may use the VM Registration Numbers in your Contract Notification email, also separated by commas.
2. Go to https://support.infoblox.com/app/licenses (you will have to log in with your support account and click the Licenses menu). On the Licenses page, open Download License Key(s) for multiple appliances.

3. Enter (or copy and paste) each of the Hardware ID values or VM Registration Numbers into the entry field, each in its own row, with a comma at the end of the value. Do not press Return between each value. An example, using VM Registration Numbers:

4. Click Generate Keys at the bottom of the panel (you may need to scroll down to show it).

The list of keys may be quite substantial. The list shows the license entitlements and registration keys for all vNIOS VMs that are purchased and listed with Infoblox Support.

5. After you receive your key values, you can save them for your records. If you need to install a specific license or licenses, you can use the method you prefer as described in the section Managing Licenses in the NIOS Administrator’s Guide, either pasting in the license data, or uploading the CSV file.

Configuring the Virtual NICs

In this section, you configure the virtual NICs for your vNIOS virtual appliance. You can define settings for up to four discrete virtual interfaces in the VM, that mirror the MGMT, LAN1, HA and LAN2 port configurations for hardware NIOS appliances. The process is straightforward.

1. From the vSphere Client, select the newly deployed vNIOS instance.
2. Click Inventory -> Virtual Machine -> Edit Settings.
3. In the Virtual Machine Properties dialog box, select the Hardware tab.
4. From the Hardware list, select one of the following based on the configuration of your vNIOS machine. For a vNIOS HA pair, you must configure both the LAN1 and HA ports for the virtual nodes.
   - Network Adapter 1: MGMT
   - Network Adapter 2: LAN1
   - Network Adapter 3: HA
   - Network Adapter 4: LAN2
5. For each network adapter, select the network of the vNIOS instance from the Network Connection drop-down menu. The list includes all networks configured for virtual machines on the host, as shown in Figure 2.2.
6. Click OK.
Figure 2.2 Virtual NIC Configuration
Chapter 3  Configuring SRE-V Service Module to Install vNIOS Appliance

This chapter provides general information about the configuration of Cisco SRE-V service module. It also describes how to install vNIOS appliance after configuring Cisco SRE-V. This chapter includes the following topic:

•  Configuring the SRE-V Service Module and Installing the vNIOS Software  on page 21
**Configuring the SRE-V Service Module and Installing the vNIOS Software**

These instructions assume that you have configured the ISR router on your network, and you are able to connect to the ISR router from your management station. For information about configuring the ISR router, refer to the Cisco documentation.

This section describes how to configure the Cisco SRE-V service module to host the vNIOS software package, including how to install the software package. The Cisco SRE-V service module uses the following interfaces to communicate with the host router: Console Manager interface, MGF (Multi-Gigabit Fabric) interface, and External Service Module interface. For information about interfaces, refer to the Cisco documentation.

Infoblox recommends that you back up your existing configuration before proceeding.

Complete the following tasks on the ISR router:

1. **Connect to the ISR router.** You must install the Cisco SRE-V service module on the router. Ensure that the Cisco router is running the appropriate Cisco IOS version and recognizes the Cisco SRE-V service module. Configure the internal interfaces between the Cisco SRE-V service module and the host router. This will allow you to access the service module to install and configure the Cisco SRE-V application. For information, refer to the Cisco documentation.

   In the following example, the router is a Cisco 3845 ISR, the gigabit Ethernet interface IP address is 10.34.28.2 with a /24 netmask, and the IP address of the SRE-V service module is 10.34.28.10.

   ```
   Enter installation commands as mentioned below:
   Router#enable
   service-module sm 1/0 install url ftp://server.com/dir/sre-v-k9.smv.1.0.1.pkg
   service-module sm 1/0 status
   exit
   Enter the following configuration commands, one per line. End with CNTL/Z.
   ```
   ```
   Router(config)#configure terminal
   Configure SM1/0 of the Console Manager:
   Router(config)#interface SM1/0
   Router(config-if)#interface unnumbered gigabitEthernet0/0
   Router(config-if)#no service-module ip default-gateway
   Router(config-if)#no service-module ip address
   Router(config-if)#ip address 10.34.28.10 255.255.255.0
   Router(config-if)#service-module ip address 10.34.72.18 255.255.255.192
   Router(config-if)#service-module ip default-gateway 10.35.1.161
   Router(config)#write
   Router(config-if)#no shutdown
   Router(config)#exit
   Application: SRE-V Running on SMV:
   ```
   ```
   Router(config-if)# service-module ip default-gateway 10.34.72.16
   Router(config-if)# service-module mgf ip address 10.34.72.68 255.255.255.192
   Router(config-if)# service-module mgf ip default-gateway 10.34.72.66
   ```
   ```
   Router(config-if)# no keepalive
   ```
Configuring SRE-V Service Module to Install vNIOS Appliance

Router(config-if)# hold-queue 60 out
Router(config)# exit

Configure SM1/1 of the Console Manager:
Router(config-if)# interface SM1/1
Router(config)# exit

Router(config)# ip route 10.34.72.18 255.255.255.255 SM1/0
Router(config)# ip route 10.34.72.68 255.255.255.255 Vlan1
Router(config)# ip route 10.34.72.70 255.255.255.255 Vlan1
Router(config)# exit

Internal switch interface connected to Service Module
Router(config-if)# switchport mode trunk
Router(config-if)# no keepalive
Router(config-if)# hold-queue 60 out
Router(config)# exit

Configure VLAN1:
Router(config-if)# interface Vlan1
Router(config-if)# ip unnumbered GigabitEthernet0/1
Router(config-if)# ip default-gateway 10.36.0.1
Router(config-if)# ip forward-protocol nd
Router(config-if)# ip http server
Router(config-if)# ip http access-class 23
Router(config-if)# ip http authentication local
Router(config-if)# ip http secure-server
Router(config-if)# ip http timeout-policy idle 60 life 86400 requests 10000
Router(config-if)# ip route 0.0.0.0 0.0.0.0 10.36.0.1
Router(config)# exit

Note: If the router is not directly connected to the network, configure the switch to which it is connected to forward the broadcast packets to the SRE-V service module.

2. Download vSphere Client from https://hypervisor-ip-address, and then click Run. The VMware vSphere Client is installed on your system. You can click the VMware vSphere Client icon to open the login window.

3. To manage a single VMware vSphere Hypervisor™, enter the IP address or hostname of the VMware vSphere Hypervisor™ and the username and password, and then click Login. The vSphere Client GUI opens.

Note: If you are a first-time user of the VMware vSphere Hypervisor™, use esx-admin for the user name and change_it for the password. Infoblox highly recommends that you change the default password after the initial reboot.

4. Check the software packages installed on the SRE-V service module. Ensure that SRE-V OS 15.1(3) T is installed before you install the vNIOS software package.

The following example shows how to check the software packages installed on an SRE-V service module.
Cisco-member.infoblox.com> show software packages

Installed Packages:
- Installer (Installer application) (1.5.2.0)
- vserialapi (Remote Serial Device support) (1.5.2)
- eventapi (IOS Event API) (1.5.2)
- Bootloader (Primary) (Service Engine Bootloader) (2.1.16)
- SRE-V (Services-Ready Engine - Virtualization)
- Infrastructure (Service Engine Infrastructure) (2.5.6.0)
- Global (Global manifest) (1.5.2)
- ios_mosipc (Cisco Multi-OS IPC support) (1.52.OMNI_TAHOE_20091104_PLUS_0_DT_REL)
- iosapi (IOS CLI API) (1.5.2)
- cli_plugin (CLI Plugin bundle to allow custom CLI plugin) (1.5.2)
- GPL Infrastructure (Service Engine GPL Infrastructure) (2.3.6.0)
- Bootloader (Secondary) (Service Engine Bootloader) (2.1.16.0)
- Core (Service Engine OS Core) (2.5.6.0)
- timezone (Time Zone Definitions) (1.0.2009g.1)
- ios_snap (Structured Network API Support) (1.5.2.SNAP_REL_20091209)

Installed Plug-ins:
- infoblox (Infoblox Virtual NIOS) (1.5.2)
- app_dev (Application Debugging Add-on Package) (1.5.2)

Install the vNIOS software package that you downloaded from the Infoblox Technical Support site. Ensure that you downloaded the appropriate vNIOS software package for your SRE-V service module. There is a vNIOS software package for SRE-V modules.

5. The installation process takes about five minutes. After the installation is complete, the appliance displays the following message:

   Infoblox started successfully
Chapter 4  Configuring vNIOS Appliance as Grid Members

This chapter provides general information about the Infoblox vNIOS virtual appliance and Infoblox Grids. It also describes how to set up a Grid and how to configure the vNIOS appliance as Grid members. It explains how to transfer licenses between vNIOS appliances. This chapter includes the following topics:

- **About Infoblox Grids** on page 25  
  - **Setting Up a Grid** on page 25
- **About Infoblox Grids** on page 25  
  - **Specifying Initial Settings on vNIOS Grid Masters** on page 26  
  - **Configuring the vNIOS Virtual Appliance as a Grid Master** on page 27
- **Configuring vNIOS Appliances as Grid Members** on page 29  
  - **Provisioning vNIOS Members on the Grid Master** on page 29  
  - **Configuring and Joining vNIOS Grid Members** on page 30
- **Transferring vNIOS Licenses** on page 31  
  - **Obtaining Replacement vNIOS Licenses** on page 31  
  - **Installing New vNIOS Licenses** on page 32  
  - **Configuring HA Pairs for License Transfers** on page 32  
  - **Removing vNIOS Appliances from the Grid** on page 33
- **Migrating vNIOS Appliances** on page 33
- **Verifying and Monitoring** on page 34
About Infoblox Grids

An Infoblox Grid is a group of two or more NIOS and vNIOS virtual appliances that share sections of a common, distributed, built-in database and which you configure and monitor through a single, secure point of access: the Grid Master. A Grid consists of a Master and at least one member. A Grid member can be a single appliance or an HA pair. For information about HA pairs, refer to the Infoblox NIOS Administrator Guide.

Figure 4.1 illustrates a Grid with a vNIOS Grid Master, a vNIOS Grid Master candidate, and NIOS and vNIOS Grid members. In the illustration, the Grid Master and the Grid Master candidate are vNIOS HA pairs in the data center. The NIOS and vNIOS Grid members are in branch offices. Smaller sites can consolidate the vNIOS appliances and other virtual applications on one virtualization server. They can manage the Grid members from one central location, the Grid Master.

Figure 4.1 Infoblox Grid with vNIOS Grid Master and Grid Members

Setting Up a Grid

To create a Grid, you must first set up a Grid Master and then add members. In a Grid, you can configure vNIOS virtual appliances as Grid Masters, Grid Master candidates, and Grid members.

To set up a Grid:

1. Configure the Grid Master. You can configure a vNIOS virtual appliance as a single Grid Master or as an HA Grid Master. To configure a vNIOS appliance as a Grid Master, you must first deploy the vNIOS appliance, and then configure it. When you configure an HA Grid Master using two vNIOS instances, ensure that you use the same vNIOS models for the Active and passive nodes. For more information, see Configuring the vNIOS Virtual Appliance as a Grid Master on page 27.

2. Provision Grid members on the Grid Master. Define Grid member settings on the Grid Master before you join the members to the Grid. For information, see Provisioning vNIOS Members on the Grid Master on page 29.

3. Join members to the Grid. For information, see Configuring and Joining vNIOS Grid Members on page 30.
Configuring vNIOS Appliances as Grid Masters

After you deploy a vNIOS appliance on the VMware platform, you can configure it as a single or an HA Grid Master. To configure a vNIOS HA Grid Master, deploy two vNIOS appliances and define the network settings for each node. The procedure is the same as joining two physical appliances as an HA pair. You must configure a Grid Master and set up the Grid before you join Grid members. For more information about configuring HA pairs, refer to the Infoblox NIOS Administrator Guide.

To configure a vNIOS appliance as a Grid Master:
1. Deploy the vNIOS appliance, as described in Deploying vNIOS Appliances on VMware on page 13.
2. Specify initial settings on the vNIOS appliance, as described in Specifying Initial Settings on vNIOS Grid Masters on page 26.
3. Configure the vNIOS appliance as a Grid Master, as described in Configuring the vNIOS Virtual Appliance as a Grid Master on page 27. For an HA Grid Master, ensure that you follow the procedures to configure node 2 of the HA pair.

Specifying Initial Settings on vNIOS Grid Masters

After you successfully install the vNIOS virtual appliance and start the vNIOS appliance, connect to the NIOS CLI and specify the initial settings. For an HA Grid Master, ensure that you specify the initial settings on both nodes.
1. From the vSphere Client, select the vNIOS instance.
2. Select the Console tab.
3. Click anywhere in the console screen to activate the console.
4. When the Infoblox login prompt appears, log in with the default user name and password.
   ```
   login: admin
   password: infoblox
   ```
   The Infoblox prompt appears: Infoblox >
5. You must have valid licenses before you can configure the vNIOS appliance. To obtain permanent licenses, first use the `show version` command to obtain the serial number of the vNIOS appliance, and then visit the Infoblox Support web site at http://support.infoblox.com. Log in with the user ID and password you receive when you register your product online at: http://www.infoblox.com/support/customer/evaluation-and-registration.
   If the vNIOS virtual appliance does not have the Infoblox licenses required to run NIOS services and to join a Grid, you can use the `set temp_license` command to generate and install a temporary 60-day license.
   The appliance lists the available licenses, and you select those you need.
   ```
   Infoblox > set temp_license
   1. DNSone (DNS, DHCP)
   2. DNSone with Grid (DNS, DHCP, Grid)
   3. Network Services for Voice (DHCP, Grid)
   4. Add DNS Server license
   5. Add DHCP Server license
   6. Add Grid license
   7. Add Microsoft management license
   8. Add vNIOS license
   9. Add IF-MAP Federation license
   10. Add Multi-Grid Management license
   11. Add Query Redirection license
   12. Add Load Balancer license
   ```
Select license (1-12) or q to quit:
For the vNIOS appliance, select 2 and 8.

**Note:** You must have both the Grid and vNIOS licenses for the vNIOS virtual appliance to join a Grid.

6. Use the CLI command `set network` to configure the network settings.

   Infoblox > set network

   NOTICE: All HA configurations are performed from the GUI. This interface is used only to configure a standalone node or to join a Grid.

   Enter IP address: 10.1.1.22
   Enter netmask: [Default: 255.255.255.0]: 255.255.255.0
   Enter gateway address [Default: 10.1.1.1]: 10.1.1.1
   Become Grid member? (y or n): n

   After you confirm your network settings, the Infoblox application automatically restarts. You can then configure the vNIOS virtual appliance as a single or HA Grid Master.

### Configuring the vNIOS Virtual Appliance as a Grid Master

You configure the vNIOS appliance as a Grid Master using the Grid Setup wizard. If you are configuring a vNIOS HA Grid Master, you complete the configuration for each virtual node in the HA pair as described in this section.

To configure the single Grid Master or node 1 of the HA Grid Master:

1. On your management system, open a new browser window, and connect to https://ip_addr, where ip_addr is the address of the single appliance or LAN1 port on node 1.
2. Log in using the default user name **admin** and password **infoblox**.
3. Review the End-User License Agreement and click **I Accept**.
4. In the Grid Setup wizard, select **Configure a Grid Master** and click **Next**.
5. Complete the following to specify the Grid properties, and then click **Next**:
   
   - **Grid Name**: Enter a text string, such as **DaveyJones**, that the Grid Master and appliances joining the Grid use to authenticate each other when establishing a VPN tunnel between them. The default Grid name is Infoblox.
   
   - **Shared Secret**: Enter a text string, such as **L0ck37**, that the Grid Master and appliances joining the Grid use as a shared secret to authenticate each other when establishing a VPN tunnel between them. The default shared secret is **test**.
   
   - **Show Password**: Select this to display the password. Clear the check box to conceal the password.
   
   - **Hostname**: Enter a valid domain name for the appliance. You can use the name that you entered for the vNIOS appliance when you deployed it.
   
   - **Is the Grid Master an HA pair?**: Select **No** for the single Grid Master. Select **Yes** for an HA pair.

6. Complete the following to configure the network settings, and then click **Next**:

   - **Host Name**: Enter a valid domain name for the appliance.
   
   - **IP Address**: Displays the IP address of the LAN port.
   
   - **Subnet Mask**: Displays the subnet mask of the LAN port.
   
   - **Gateway**: Displays the IP address of the gateway of the subnet on which the LAN port is set.
   
   - **Port Settings**: The default is **Automatic**. You cannot change port settings for vNIOS appliances.

7. For an HA pair, complete the following to specify the network properties and click **Next**:

   - **Virtual Router ID**: Enter the VRID (virtual router ID). This must be a unique VRID number—from 1 to 255—for this subnet.
Configuring vNIOS Appliance as Grid Members

— **Required Ports and Addresses:** Enter information about the following virtual interfaces: VIP, Node 1 HA and LAN ports, Node 2 HA and LAN ports. The VIP address and the IP addresses for all the ports must be in the same subnet. Enter the IP address of the gateway for the subnet on which the interfaces are set. This is the same for all interfaces. All fields are required. Note that you cannot change the port settings.

8. Optionally, enter a new password and click **Next.** The password must be a single hexadecimal string (no spaces) that is at least four characters long.

9. Select the time zone of the Grid Master and indicate whether the Grid Master synchronizes its time with an NTP (Network Time Protocol) server, and then click **Next.**
   
   — If you choose to enable NTP, click the Add icon and enter the IP address of an NTP server. You can enter IP addresses for multiple NTP servers.
   
   — If you choose to disable NTP, set the date and time for the appliance.

10. The last screen displays the settings you specified in the previous panels of the wizard. Verify that the information is correct and click **Finish.** The application restarts after you click **Finish.**

**Note:** The Grid Setup wizard provides options such as not changing the default password and manually entering the time and date. However, changing the password and using an NTP server improve security and accuracy (respectively), and so these choices are presented here.

Record and retain this information in a safe place. If you forget the shared secret, you need to contact Infoblox Technical Support for help. When you add an appliance to the Grid, you must configure it with the same Grid name, shared secret, and VPN port number that you configure on the Grid Master.

The last screen of the setup wizard states that the changed settings require the appliance to restart. When you click **Finish,** the appliance restarts.

For an HA pair, complete the following to configure node 2 using the Grid Setup wizard:

1. On your management system, open a new browser window, and connect to https://ip_addr, where *ip_addr* is the address of the LAN1 port on node 2.

2. Log in using the default user name and password **admin** and **infoblox.**

3. Review the End-User License Agreement and click **I Accept.**

4. In the Grid Setup wizard, select **Join Existing Grid** and click **Next.**

5. Complete the following to specify the Grid properties and click **Next**
   
   — **Grid Name:** Enter the Grid name you entered for node 1.
   
   — **Grid Master’s IP Address:** Enter the VIP you entered for node 1.
   
   — **Shared Secret:** Enter the shared secret you entered for node 1.

6. Verify the IP address settings of the member and click **Next.**

7. The last screen displays the settings you specified in the previous panels of the wizard. Verify that the information is correct and click **Finish.**

The setup of the HA Grid Master is complete. If the two nodes cannot join (it should not take more than a few seconds), check the IP addresses of Node 1 LAN and Node 1 HA (the Grid Master) and for Node 2 LAN and Node 2 HA (the node attempting to join the Grid Master to form the HA Pair). Ensure that the network IP address of node 2 is set to the same value as Node 2 LAN on the Grid Master.

As a method of verifying successful communication, open the console window for node 2. You should see a pair of messages as follows:

- **Contacting the Grid Master at 10.36.0.200....**
- **Synchronizing database with the Grid Master....**

For more information about HA pair configurations, refer to the **Infoblox NIOS Administrator Guide.**
Configuring vNIOS Appliances as Grid Members

You can configure a vNIOS appliance as a single Grid member, or two vNIOS appliances as a vNIOS HA Grid member. To configure a vNIOS HA Grid member, deploy two vNIOS appliances and define the network settings for each node. Connect to the Grid Master and specify the two vNIOS appliances as nodes in the HA pair. The procedure is the same as joining two physical appliances as an HA pair. You must configure a Grid Master and set up the Grid before you join Grid members. For information, see Setting Up a Grid on page 25.

To configure a vNIOS appliance as a Grid member:
1. Deploy the vNIOS appliance, as described in About Infoblox Grids on page 25.
2. Define the vNIOS appliance on the Grid Master, as described in Provisioning vNIOS Members on the Grid Master.
3. Specify the initial settings and join the vNIOS appliance to the Grid, as described in Configuring and Joining vNIOS Grid Members on page 30.

Provisioning vNIOS Members on the Grid Master

Before you configure the individual appliances that you want to add to the Grid, you must first define them on the Grid Master, as follows:
1. Log in to the Grid Master.
2. From the Grid tab, select the Grid Manager tab -> Members tab, and then click Add -> Add Grid Member from the Toolbar.
3. In the Add Grid Member wizard, enter the following and click Next:
   - **Member Type**: Select Virtual NIOS.
   - **Host Name**: Type the FQDN (fully qualified domain name) of the vNIOS single or HA appliance that you want to add to the Grid.
   - **Time Zone**: If the vNIOS Grid member is in a different time zone from the Grid, click Override and select a time zone.
   - **Comment**: Enter useful information about the vNIOS appliance.
4. Enter the following information about the member that you want to add to the Grid and click Next:
   For a single Grid Member:
   - **Standalone Member**: Select this option.
   - **Address**: Type the IP address of the vNIOS Grid member.
   - **Subnet Mask**: Choose the netmask.
   - **Gateway**: Type the IP address of the default gateway of the vNIOS Grid member.
   - **Port Settings**: The default is Automatic. You cannot change port settings for vNIOS appliances.
   For an HA Grid member:
   - **High Availability Pair**: Select this option.
   - **Virtual Router ID**: Enter a unique VRID number—from 1 to 255—for the local subnet.
   - **Required Ports and Addresses**: Enter information about the following virtual interfaces: VIP, Node 1 HA and LAN ports, Node 2 HA and LAN ports. The VIP address and the IP addresses for all the ports must be in the same subnet. Enter the IP address of the gateway for the subnet on which the interfaces are set. This is the same for all interfaces. All fields are required. Note that you cannot change the port settings.
5. Optionally, define extensible attributes. For information, refer to the Infoblox NIOS Administrator Guide.
6. Save the configuration and click **Restart** if it appears at the top of the screen.
Configuring and Joining vNIOS Grid Members

After you successfully install the vNIOS virtual appliance and start the vNIOS appliance, connect to the NIOS CLI and specify the initial settings. If you are configuring a vNIOS HA Grid member, you must complete the following steps for each virtual node in the HA pair.

1. Connect to the Grid Master where you can add the vNIOS appliance to the Grid.
2. From the vSphere Client, select the vNIOS instance.
3. Select the Console tab.
4. Click anywhere in the console screen to activate the console.
5. When the Infoblox login prompt appears, log in with the default user name and password.

   login: admin
   password: infoblox

   The Infoblox prompt appears: Infoblox >

6. You must have valid licenses before you can configure the vNIOS appliance. To obtain permanent licenses, first use the `show version` command to obtain the serial number of the vNIOS appliance, and then visit the Infoblox Support web site at http://www.infoblox.com/support. Log in with the user ID and password you receive when you register your product online at: http://www.infoblox.com/support/customer/evaluation-and-registration.

   If the vNIOS appliance does not have the Infoblox licenses required to run NIOS services and to join a Grid, you can use the `set temp_license` command to generate and install a temporary 60-day license. The appliance lists the available licenses and you select those you need.

   Infoblox > `set temp_license`
   1. DNSone (DNS, DHCP)
   2. DNSone with Grid (DNS, DHCP, Grid)
   3. Network Services for Voice (DHCP, Grid)
   4. Add DNS Server license
   5. Add DHCP Server license
   6. Add Grid license
   7. Add Microsoft management license
   8. Add vNIOS license
   9. Add IF-MAP Federation license
   10. Add Multi-Grid Management license
   11. Add Query Redirection license
   12. Add Load Balancer license

   Select license (1-12) or q to quit:

   **Note:** You must have both the Grid and vNIOS licenses for the vNIOS appliance to join a Grid.

7. Set the network settings and join the vNIOS appliance to the Grid. Use the CLI command `set network` to configure the network settings and specify the Grid.

   Infoblox > `set network`
   NOTICE: All HA configurations are performed from the GUI. This interface is used only to configure a standalone node or to join a Grid.

   Enter IP address: 10.1.1.11
   Enter netmask: [Default: 255.255.255.0]: 255.255.255.0
   Enter gateway address [Default: 10.1.1.1]: 10.1.1.1
   Become Grid member? (y or n): y
   Enter Grid Master VIP: 10.1.1.22
   Enter Grid Shared Secret: L0ck37
   Join Grid as member with attributes:
   Grid Master VIP: 10.1.1.22
   Grid Name: DaveyJones
   Grid Shared Secret: L0ck37
   WARNING: Joining a Grid will replace all the data on this node!
Transferring vNIOS Licenses

In a Grid, you can transfer the valid licenses of a vNIOS appliance from one ESX/ESXi server to another without going through the RMA (returned materials authorization) process. You can also transfer licenses from one independent vNIOS appliance to another. Before you transfer licenses, obtain new license keys through the Infoblox Support web site. The new licenses replace the original ones. Note that when you replace licenses on vNIOS appliances, service interruptions can occur.

Note: Once licenses are removed from a vNIOS appliance, the appliance can no longer join the Grid. You must remove the appliance from the Grid and stop using it.

Complete the following to transfer vNIOS licenses from one vNIOS appliance to another:
1. Obtain replacement license keys from Infoblox, as described in Obtaining Replacement vNIOS Licenses.
2. Install the new licenses on the new vNIOS appliance, as described in Installing New vNIOS Licenses on page 32.
   or
   As a best practice to minimize service downtime, you can set up an HA pair and force a failover during a license transfer. For information, see Configuring HA Pairs for License Transfers on page 32.
3. Remove the original vNIOS appliance from the Grid, as described in Removing vNIOS Appliances from the Grid on page 33. You can skip this step for independent vNIOS appliances.
4. Shut down the original vNIOS appliance.
5. Verify that all licenses are now current. For information, see Verifying and Monitoring on page 34.

After you transfer vNIOS licenses, you can view information about the new and replaced licenses from Grid Manager. Though you can transfer licenses among vNIOS appliances more than once, Grid Manager displays information about the first license transfer only. For more information about managing and viewing licenses, refer to the Infoblox NIOS Administrator Guide. You can also use the CLI command `show license revoked` to view information about the replaced licenses. For information, refer to the Infoblox CLI Guide.

Obtaining Replacement vNIOS Licenses

To obtain replacement license keys for your vNIOS appliance, do the following:
2. Click License Key in the left panel.
3. In the Software Licensing Tools panel, select vNIOS for VMware License REVOCATION.
4. On the Virtual Appliance License Key page, complete the following:
   — **Existing Appliance Serial Number**: Enter the hardware ID of the vNIOS appliance that you want to replace.
   — **New Appliance Serial Number**: Enter the hardware ID of the new vNIOS appliance.
   Select one of the following:
   — **Display to Screen**: Select this to display the license keys on the screen.
   — **Send to file**: Select this to receive a license file that contains the new license keys.
   — **CSV text**: Select this to receive the license keys in CSV format.
5. Click **Generate Key**.
   Infoblox generates new license keys for your new vNIOS appliance.
Installing New vNIOS Licenses

To install replacement licenses on a vNIOS appliance, do the following:

1. Configure the new vNIOS appliance and join it to the Grid if it is not already in the Grid, as described in Configuring and Joining vNIOS Grid Members on page 30.

2. Log in to the Grid Master GUI.

3. From the Grid -> Licenses tab, click the Add icon and complete the following to add the new license keys:
   - **Upload License File**: Click Select File and navigate to the new license file you obtained from Infoblox.
   - **Paste License(s)**: Paste the license keys in this text field. You must paste the entire string in CSV format: serial number, hardware ID, license type, end date, and license string. If you are pasting multiple licenses, start each string on a new line.

   You can also use the CLI command `set license` to install the new licenses. For information, refer to the Infoblox CLI Guide.

4. Click **Save License(s)**.

   Grid Manager displays a confirmation dialog box listing information (license type, license string, and hardware ID) about the member you want to replace and asks if you want to continue. Click **OK** to install the licenses on the new member, or click **Cancel** to cancel the operation.

   The new licenses automatically replace the old ones, and the replaced vNIOS appliance is evicted from the Grid.

5. Remove the replaced appliance from the Grid, as described in Removing vNIOS Appliances from the Grid on page 33.

Configuring HA Pairs for License Transfers

To minimize service downtime during a vNIOS license transfer, do the following:

1. Create an HA member. Configure the existing vNIOS appliance as the active node. Install temporary licenses on the new vNIOS appliance and configure it as the passive node, as described in Configuring and Joining vNIOS Grid Members on page 30. For more information about how to configure an HA pair, refer to the Infoblox NIOS Administrator Guide.

2. Provision the HA member on the Grid Master and rejoin the HA member to the Grid so the passive node can synchronize with the Grid Master. For information, see Provisioning vNIOS Members on the Grid Master on page 29.

3. Reboot the active node to force a failover on the HA pair. The new vNIOS appliance now becomes the active node.

4. Log in to the Grid Master GUI.

5. From the Grid -> Licenses tab, click the Add icon and complete the following to add the new license keys to the HA pair:
   - **Upload License File**: Click Select File and navigate to the new license file you obtained from Infoblox.
   - **Paste License(s)**: Paste the new license keys in this text field. You must paste the entire string in CSV format. Note that the new license key is longer because it contains the hardware ID of the existing vNIOS appliance.

   You can also use the CLI command `set license` to install the new licenses. For information, refer to the Infoblox CLI Guide.

6. Click **Save License(s)**. Grid Manager displays a confirmation dialog box listing information (license type, license string, and hardware ID) about the member you want to replace and asks if you want to continue. Click **OK** to install the licenses on the new member, or click **Cancel** to cancel the operation.

   The new licenses automatically replace the old ones, and the replaced vNIOS appliance is evicted from the Grid.

7. Remove the replaced appliance from the Grid, as described in Removing vNIOS Appliances from the Grid.
Removing vNIOS Appliances from the Grid

1. From the Grid -> Grid Manager -> Members tab, select the appliance whose licenses were removed. Grid Manager displays a license violation warning for this appliance, as shown in Figure 4.4.
2. Click the Delete icon to remove the appliance from the Grid.
   You can also log in to the vNIOS appliance whose licenses are being replaced, and then use the CLI command `reset licenses all` to reset the licenses and remove the appliance from the Grid.

   **Note:** You must stop using the virtual appliance and remove it from the Grid once its licenses are replaced.

Migrating vNIOS Appliances

You can use the VMware vMotion feature to migrate a vNIOS virtual appliance from one ESX or ESXi server to another.

To migrate a vNIOS appliance using vMotion:
1. From the vSphere Client, right-click the vNIOS virtual appliance you want to migrate.
2. Select Migrate....
3. In the Migrate Virtual Machine dialog box, select Change Host.
4. In the Select Destination dialog box, select the ESX or ESXi server to which you want to migrate the vNIOS virtual appliance.
5. Click Next, and then click Finish to complete the migration.
Verifying and Monitoring

After you configure the vNiOS appliance, you can check its status on the Dashboard and in the Grid -> Grid Manager -> Members tab, as shown in Figure 4.2 and Figure 4.3.

Figure 4.2 vNiOS Appliance Status on the Dashboard

![vNiOS Appliance Status on the Dashboard](image)

Figure 4.3 vNiOS Appliance Status in the Members Tab

![vNiOS Appliance Status in the Members Tab](image)
After a license transfer, you must remove the vNIOS appliance whose licenses are replaced. Grid Manager displays a license violation warning for this member if it is still operational, as shown in Figure 4.4. You must immediately remove this member from the Grid and stop using the appliance until you obtain valid licenses for it.

Figure 4.4 A vNIOS Appliance with Invalid Licenses after a License Transfer

The appliance displays a license violation warning if you do not remove the vNIOS appliance that has invalid licenses after a license transfer.

In the Grid -> Licenses tab, you can view information about licenses that are being replaced, as shown in Figure 4.5. The Replaced Hardware ID column displays the hardware ID of the vNIOS appliance whose licenses are being replaced. Note that the hardware IDs of the licenses that are being replaced are highlighted in red.

Figure 4.5 Information about Replaced Licenses
Appendix A Known Limitations

vNIOS virtual appliance for VMware support most of the features of the Infoblox NIOS appliances, with the following limitations:

- The IB-BOB virtual appliance is supported on Cisco SRE-V and can function as a Grid member only. It does not support configuration as an independent appliance, an HA pair, a Grid Master, or a Grid Master candidate. It also does not support access to the Infoblox GUI.
- The IB-VM-250 virtual appliance supports all the services provided by vNIOS virtual appliances, but it is not recommended as a Grid Master or Grid Master candidate.
- The Captive Portal is supported only on IB-VM-1050 virtual appliances.
- When you configure an HA pair, both nodes in the HA pair must be vNIOS instances. You cannot configure a physical NIOS appliance and a vNIOS instance in an HA pair.
- vNIOS appliances run on virtual hardware. They do not have sensors to monitor the physical CPU temperature, fan speed, and system temperature.
- Changing the vNIOS appliance settings through the VMware vSphere or vCenter console may violate the terms of the vNIOS licensing and support models. The vNIOS appliance may not join the Grid or function properly.
- The bloxTools environment is not support on vNIOS virtual appliances.